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Getting Started 
 

Welcome 
GoToMeeting’s “simpler is better” approach to online meetings makes it the easiest, fastest, 
most cost-efficient and secure online presentation and collaboration service available. 

GoToMeeting users can collaborate on documents, deliver presentations, perform product 
demonstrations and securely share confidential information from anywhere, at any time.  
GoToMeeting’s rapid download, quick meeting setup and intuitive user interface has meeting 
organizers and attendees up and running in a matter of seconds. 

GoToMeeting incorporates industry-standard security features and end-to-end SSL encryption 
to ensure that login information and meeting data are secure. The GoToMeeting architecture is 
the most advanced security foundation available on the market and offers meeting hosts and 
attendees true end-to-end data security. The high level of security provides a greater sense of 
safety to meeting participants and allows GoToMeeting users to confidently present and 
collaborate on any data. Users can rest assured that information such as sales forecasts, 
financial data and M&A contracts will not be viewable to anyone except meeting participants. 

With GoToMeeting, travel costs can be dramatically reduced or eliminated because meetings 
can be held online with anyone, anywhere. Spend time meeting online rather than traveling, 
getting through security or waiting in airports. 

GoToMeeting’s All You Can Meet™ pricing model provides easy-to-understand billing that helps 
you effectively budget and manage online meeting costs with no unexpected overage charges 
or additional fees. 

The emerging leader in online meeting technology, GoToMeeting was designed to make it 
easier for everyone to organize and participate in online meetings. Make every meeting a 
GoToMeeting and get more meeting done. 
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Using This Guide 
 

Guide Structure 

This guide is divided into five sections: 

• The GoToMeeting Web Site - This section is for GoToMeeting organizers and covers 
how to access and use the GoToMeeting Organizer Web site. 

• Organizing and Conducting Meetings – This section is for GoToMeeting organizers 
and covers how to schedule, view, edit, delete, start, conduct and manage attendees at 
scheduled and impromptu GoToMeeting meetings. 

• Presenting at Meetings – This section is for any GoToMeeting attendee who may be 
given the role of presenting during a meeting. The section covers how to use 
GoToMeeting Presenter controls. 

• Attending Meetings – This section is for any GoToMeeting attendee and covers how to 
join a meeting and how to use attendee features. 

 

 

 

Personal and Corporate Users 

This user guide addresses both personal GoToMeeting users and GoToMeeting Corporate users. 
While most features apply to both audiences, some content relates to just one audience. To 
help you identify when something is just for one specific audience, this guide will clearly note 
the audience for any user-specific content. 
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System Requirements 
For Organizers 

• Required: Windows® 2000, XP Home, XP Pro, 2003 Server, Vista 

• Required: Internet Explorer® 5.0 or newer, Netscape® 6.0 or newer or Mozilla® 
Firefox® 1.0 or newer 

• Required: Stable 56k, cable modem, ISDN, DSL or better Internet connection 

• Recommended: Minimum of Pentium® 400 MHz with 256 MB of RAM 

For PC-based Attendees 

• Required: Windows 2000, XP Home, XP Pro, 2003 Server, Vista 

• Required: Internet Explorer 5.0 or newer, Netscape 6.0 or newer or Mozilla Firefox 1.0 
or newer 

• Required: Stable 56k, cable modem, ISDN, DSL or better Internet connection 

• Recommended: Minimum of Pentium 400 MHz with 256 MB of RAM 

For Macintosh®-based Attendees 

• Required: Mac OS® X 10.3.9 (Panther®) or newer 

• Required: Safari™ 1.3 or newer, Firefox 1.5 or newer on PowerPC G3/G4/G5, or Firefox 
1.5.0.2 or newer on Intel® (JavaScript™ and Java™ enabled) 

• Required: Stable 56k, cable modem, ISDN, DSL or better Internet connection 

• Required: PowerPC G3/G4/G5 or Intel processor (G4 450 MHz with 256 MB of RAM or 
better recommended) 

 

For Meeting Recording 
• Required: Windows 2000, XP Home, XP Pro, 2003 Server, Vista 

• Required: Windows Media® Player Version 9.0 or greater  

• Required: Minimum Super VGA (800x600) or better   

• Recommended: 1.0 GB of hard disk space  

• Recommended: 1024 x 768 or higher screen resolution  

• Recommended: Minimum Pentium 800 MHz with 256 MB of RAM for transcoding to 
Windows Media Player file format 

 

For Instant-Messaging Integration 
• GoToMeeting integrates with the most widely used instant-messaging applications 

including: Yahoo!® Messenger™, Windows Live™ Messenger, Skype™ Chat, Microsoft® 
Communicator, Google Talk™ 

Note: Instant-Messaging Integration options are only available for use by GoToMeeting organizers. 

For Microsoft® Office® Integration 

• Microsoft® Office® 2002 or later 

For Outlook Integration 

• Microsoft® Outlook® 2000 or later 

For Lotus Notes® Integration 

• IBM® Lotus Notes® Version 6.5 
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Terms 
• Organizer – Organizers have accounts with GoToMeeting that enable them to schedule 

and conduct meetings. Organizers are also the meeting host and the initial meeting 
presenter, but may pass the presenter role to any other attendee. Organizers have the 
ability to grant or revoke attendee privileges, invite or dismiss attendees during a 
meeting and make other attendees organizers. 

• Attendee – An attendee is any person who attends a meeting – including organizers, 
and presenters.  By default, attendees can view the presenter's screen. An attendee 
may remotely control the presenter's computer screen if given the privilege. An 
attendee may chat with other attendees or view the Attendee List. 

• Presenter – A presenter is any attendee who is giving a presentation and shares his or 
her computer screen with all the attendees. The initial presenter is also the initial 
meeting organizer. The presenter also determines who gets to control the keyboard and 
mouse of the remotely viewed screen. 

• GoToMeeting Web Site – The Web site located at www.gotomeeting.com is used by 
organizers to manage their accounts and host meetings and by attendees to join 
meetings. 

• GoToMeeting System Tray Icon – The system tray icon is used to access organizer 
features of GoToMeeting and to provide status of GoToMeeting service. To access 
organizer features, right-click the system tray icon and select the desired feature. 

 

Icon Description 

 GoToMeeting is in Session – A meeting is in progress. 

 
GoToMeeting is Starting/Stopping – The application is starting up or shutting down. 
When this icon is showing, the user will not have any menu options. 

 
GoToMeeting is Connecting – The application is attempting to establish a connection 
with the server. This icon is animated to look like it is “filling up”. While connecting, 
the user has a very limited set of menu options (Help, About, Exit). 

 
GoToMeeting is Ready – A connection has been made, and the application is ready to 
be used. The user has all menu options available. 

 
GoToMeeting is Offline – A connection has been made, but there is some temporary 
network difficulty. The user will still have all menu options available. 

 
GoToMeeting is Not Connected – A connection could not be established. The user has 
a very limited set of menu options (Help, About, Exit). 

• Account Password – An account password is what organizers use to log in to the 
GoToMeeting Web site. It must contain at least eight characters and include both letters 
and numbers. 

• Meeting Password – A meeting password is an optional value chosen by the meeting 
organizer that is used to help authenticate attendees. Requiring and specifying a 
meeting password provides enhanced privacy guarantees for the meeting by ensuring 
that only attendees that know the meeting password may join the meeting. The 
meeting password is never transmitted to Citrix Online in any form. The meeting 
password may be any alphanumeric string of one character or more the organizer would 
like such as: "7891," "Happy Birthday," "Citrix123," etc. Picking a meeting password 
that is difficult to guess helps to maximize security. 

• Viewer – The Viewer is the window displayed on the attendees’ computers in which the 
presenter’s PC desktop or shared application appears. The Viewer Window has its own 
title and menu bars. 

© 2007 Citrix Online, LLC. All rights reserved.  8 
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• Presenter’s PC Image – The presenter’s PC image is the picture of the presenter’s PC 
desktop or shared application that appears to attendees in the Viewer Window. 

• Published Application – An application that is pushed to a client PC by Citrix 
Presentation Server. 
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Product Features 
• Intuitive User Interface: Easy-to-understand controls enable you to start and join 

meetings in seconds without training. 

• Specific Application Sharing: Limits application sharing to the one application 
organizers choose, so they don’t have to share their entire desktops, or worry about 
receiving distracting pop-ups from instant messages or email. 

• Screen Clean: Presenters can click this option to instantly hide icons, wallpaper 
background and toolbars on their desktops, so attendees won’t be distracted by them. 

• Share Keyboard and Mouse Control: Securely collaborate on documents in real time. 

• Instantly Change Presenters: Enable any participant to present to the entire group. 

• Desktop Recording and Meeting Playback: Allows users to record and play back 
meeting sessions to review meetings or send copies to absent colleagues or customers. 

• Chat Window: Chat online with any participant in the meeting. 

• Drawing Tools – Pen, Highlighter, Arrow, Spotlight: Gives all attendees the ability 
to draw, highlight and point to items of interest right on the screen. Presenters have 
additional ability to use the spotlight and can erase all markings on the screen.  

• Multiple Monitor Support: Integrates GoToMeeting with multiple monitor systems, so 
users can use one for screen sharing and the other for different tasks, or share all of 
their screens. 

• Transparent Control Panel: Allows presenters to keep their control panel open on 
their screen while screen sharing and chatting. 

• Inactivity Time-Out: Provides added security by automatically stopping screen 
sharing after a specified period of inactivity (i.e., no keyboard or mouse movement). 
Default is 30 minutes, but setting is configurable up to one hour. 

• Integration: Easily start or join GoToMeeting sessions through various email and 
instant-messaging applications. 

• Attendee Authority: Grant and revoke attendee privileges before or during a meeting 
session. 

• Reporting: Get detailed reports for trend analysis and ROI validation. 

• True 24-Bit Color: Share presentations, graphics, pictures and PC applications with all 
meeting attendees in True 24-bit color. 

 

 

Feature Notes 
• Organizers using GoToMeeting are limited to 15 meeting attendees, plus the organizer, 

for a total of 16 people in each meeting. 

• Organizers using both GoToMeeting and GoToMeeting Corporate may invite up to 25 
meeting attendees, for a total of 26 people in each meeting.  
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Create Your Organizer Account – Personal Plan Organizers 
Before they can schedule or start a meeting, first-time organizers need to create their 
GoToMeeting accounts and download the GoToMeeting software. It generally takes less than 2 
minutes to set up a GoToMeeting account. 

 To create your account 

1. Go to www.gotomeeting.com and click the Try It Free button. 

2. On the Create Account page, enter your information and click Create Account. 

3. On the Download GoToMeeting page, click the Download button. 

4. If prompted, click Yes or Grant to accept the download. 

 

Create Your Organizer Account – Corporate Plan Organizer 
If you are a GoToMeeting Corporate user you will be invited to join by your company’s 
GoToMeeting Administrator. Before being able to schedule or start a meeting you need to 
create your GoToMeeting account and download the GoToMeeting software. 

 To create your account 

1. Go to your email application and open the GoToMeeting invitation email you received 
from your administrator entitled Set Up GoToMeeting Corporate. 

2. In the email, click the activation link to create your organizer account. 

3. On the Create Account page, enter your information and click Create Account. 

4. On the Download GoToMeeting page, click the Download button. 

5. If prompted, click Yes or Grant to accept the download. 

© 2007 Citrix Online, LLC. All rights reserved.  11 
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Install the GoToMeeting Application 

The GoToMeeting application must be on the computer in order to schedule and host meetings. 
The application will automatically download with creation of your organizer account. 

 To install the GoToMeeting application 

1. Open an Internet browser and go to www.gotomeeting.com.  

2. In the left navigation bar, click Log In. 

3. In the Returning Users section, enter your email address and password and click the 
Log In button. 

You will be logged in to your Organizer Web site and taken directly to the My Meetings 
page. 

4. At the bottom of the My Meetings page, click the re-install the GoToMeeting 
software link. 

5. The GoToMeeting application downloads to your computer. 

6. The GoToMeeting application is installed on your computer; the GoToMeeting icon 
appears in your system tray and is ready for use. 

 
 

http://www.gotomeeting.com/
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The GoToMeeting System Tray Icon 

The GoToMeeting system tray icon provides convenient access to all GoToMeeting functions. To 
access functions, simply right-click the system tray icon and select the desired function. 

 

 

 

 

 

 

 

 

 

Meet Now… 
Enables organizers to immediately 
start impromptu meetings without 

needing to enter meeting information 

Join a Meeting… 
Enables organizers to join meetings 
from the system tray icon 

My Meetings 
Provides organizers access to their 

scheduled meetings and the ability to 
add, edit or delete scheduled 

meetings 

Preferences 
Provides access to user preferences 

Help 
Launches online help 

About 
Provides GoToMeeting software 

version information 

Exit 
Closes the GoToMeeting application 

Schedule a Meeting… 
Enables organizers to schedule 
meetings 



GoToMeeting™ User Guide 

Set GoToMeeting Application Preferences 

GoToMeeting preferences allow organizers to set preferences for running GoToMeeting, choose 
which GoToMeeting integrations are displayed and test the GoToMeeting connection. 

 

 To set GoToMeeting preferences from the system tray icon 

1. Right-click the GoToMeeting system tray icon and select Preferences. 

2. Select the appropriate category for the set of preferences you want to customize – Start 
Up, General, Meetings, Recording, Integrations or Connection. 

3. Select your preferences. 

4. Click OK. 

 To set GoToMeeting preferences from the Control Panel during a meeting 

1. When in a meeting, select Preferences from the Tools menu in the control panel. 

2. Select the appropriate category for the set of preferences you want to customize  

3. Select your preferences. 

4. Click OK. 

 
Note: Preference options outlined in this guide are specific to GoToMeeting. If your account is GoToWebinar enabled, 
additional preference options will appear. For more information on GoToWebinar preference options, please refer to the 
Getting Started section of the GoToWebinar Guide at www.gotowebinar.com/help. 

 

 

 

Start Up 

The Start Up category enables organizers to determine how to start GoToMeeting. Options 
include: 

1. “Automatically after I log in to Windows” – This option starts GoToMeeting automatically 
after you log in to your PC. 

2. “Manually” – This option sets GoToMeeting to start only when you launch the 
application from your Programs Menu. 

3. Log in checkbox: “Remember me on this computer” – This will enable automatic log in 
to the system. 

1. “Remind me of upcoming meetings” – This checkbox becomes available if you 
select “Remember me on this computer” and will provide you with reminders for 
your scheduled meetings. 

2. “Periodically synchronize reminders with My Meetings” – This preference option 
is applicable to users of Citrix Presentation Server and is the recommended 
setting for optimal use. This checkbox becomes available if you select the 
Remind me of upcoming meetings checkbox and will synchronize meetings 
scheduled from a published Outlook® or Lotus Notes® with a local installation of 
GoToMeeting. 

© 2007 Citrix Online, LLC. All rights reserved.  14 
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General  

The General category enables organizers to set general preferences. 

 

1. “File save settings” – enables you to save the Chat Log to any drive or directory. 

2. Security – Enables you to set the inactivity time-out, which will automatically stop 
screen sharing if there is no keyboard input or mouse movement for the specified 
period of time. 

3. “Desktop notifications” – This option enables/disables various system messages to 
appear to an organizer when specific meeting actions occur. 

 

Meetings 

The Meetings category enables organizers to determine what GoToMeeting options are 
available to attendees during a meeting and set the default preferences for what the organizer 
sees during a meeting. Options include: 

 

1. Enabling or disabling the 
ability for attendees to 
chat and view the 
Attendee List. 

2. Enables the organizer to 
create a Chat Welcome 
Message that will be 
sent to each attendee 
upon joining the 
meeting. 

3. Enabling or disabling 
various system 
messages to appear to 
the organizer when 
specific meeting actions 
occur. 

4. Selecting the desired 
color for your 
GoToMeeting Viewer 
and Control Panel. 

 

 

 

 

 
Note: If you disable the chat bubble option, a new message icon will appear on the Grab Tab to notify you of new chat  
messages as they are received.  
 

 Designates a private chat                     Designates a public chat 
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Recording 

1. Allows you to enable or disable the recording audio feature and select an input device 
such as a microphone.  

2. Allows you to select the meeting recording output format and destination for saving the 
file. 

 

Integrations 

The Integrations tab enables organizers to determine where to display GoToMeeting 
integrations. Options include: 

 

1. “Use GoToMeeting with” – This 
option allows you to select your 
GoToMeeting email and calendar 
integration. Selecting "My default 
email application" allows 
integration with MAPI-compliant 
email/calendar programs other 
than Microsoft Outlook and Lotus 
Notes; depending on your email 
application's capabilities, 
integration with MAPI-enabled 
programs allows for features such 
as automatically adding meetings 
to a calendar and automatic 
creation of email messages with 
meeting information.  

2. “Show button in messenger 
applications” – This option 
displays the GoToMeeting Quick Launch 
button in selected instant-messaging 
applications.  

Note: Changes may only be displayed after restarting Outlook, Lotus Notes and/or the instant-messaging application. 

 

Connection 
The Connection category enables organizers to test the status of the GoToMeeting connection. 

Note: To ensure a valid connection test, we advise that you refrain from testing your connection unless a 
GoToMeeting Customer Care representative directs you to perform the connection test. 
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he GoToMeeting Outlook Bar 

k and easy access to GoToMeeting functions right 

T
The GoToMeeting Outlook Bar provides quic
from Microsoft Outlook. It includes the Meet 
Now and Schedule Meeting buttons, in addition 
to access to all the same features of 
GoToMeeting that the GoToMeeting system tray 
icon provides.  

 

 

 

Note: Outlook integration requires Microsoft Outlook 2000 or later. Outlook may need to be shut down and restarted 
for the GoToMeeting Outlook bar to appear. The GoToMeeting Outlook bar can be added or removed from the 
Preferences Menu.  Organizers using the Outlook published by Citrix Presentation Server may need to manually add 
the Outlook toolbar from the Outlook tools menu. For more details, see the Set Up GoToMeeting for Use with Citrix 
Presentation Server section of this guide. 
 
The GoToMeeting Lotus Notes Menu Options 

e GoToMeeting Lotus Notes menu options provide quick and easy access to GoToMeeting 
he Meet Now and Schedule 

 

Th
functions right from the IBM Lotus Notes interface. It includes t
Meeting buttons, in addition to access to your My Meetings dialog box. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Lotus Notes integration requires IBM Lotus Notes 6.5. Lotus Notes may need to be shut down and restarted for 
the GoToMeeting menu options to appear. The GoToMeeting Lotus Notes menu options can be added or removed from 
the GoToMeeting Preferences Menu. Organizers using Citrix Presentation Server should contact their Presentation 
Server Administrator to display or remove the GoToMeeting Lotus Notes menu options in their published IBM Lotus 
Notes. 
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The GoToMeeting Messenger Button 
The GoToMeeting Messenger button provides a convenient way to start an impromptu meeting, 
right from your selected instant-messaging application.  

 

Note: Please see the Software Requirements section to check what instant-messaging products and versions are 
supported. Messenger applications may need to be shut down and restarted for the GoToMeeting Messenger button to 
appear. The GoToMeeting Messenger button can be added or removed from the Preferences Integrations tab. 

 

 

 

Set Up GoToMeeting for Use with Citrix Presentation Server 
Preferences 

Depending on your Presentation Server environment, your Presentation Server Administrator 
can choose to configure your GoToMeeting settings for you without notifying you; configure 
your settings and notify you of those settings; or allow you to configure them yourself. If your 
Administrator has chosen your configurations for you, you won’t need to do anything; if your 
Administrator has configured your settings and opted to notify you, you will see a notification 
dialog when you start your first meeting from your published environment. 

 

If your Citrix Presentation Server Administrator has not already configured your GoToMeeting 
preferences, the recommended settings can be configured under the Start Up category and 
the Integrations category in the Preferences dialog. 
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Recommended settings for the Start Up tab: 

1. Enable “Remind me of 
upcoming meetings” – 
This checkbox 
becomes available if 
you select 
“Automatically log in 
to GoToMeeting” and 
will provide you with 
reminders for your 
scheduled meetings. 

 

2. Enable “Periodically 
synchronize reminders 
with My Meetings” – 
This preference option 
is applicable to users 
of Citrix Presentation 
Server and is the 
recommended setting 
for optimal use. This 
checkbox becomes available if you select the Remind me of upcoming meetings 
checkbox and will synchronize meetings scheduled from a published Outlook® or Lotus 
Notes® with a local installation of GoToMeeting. 

 

Recommended settings for the Integrations category: 

1. Select your desired integration from the list of GoToMeeting integrations 

2. Click the Advanced button and confirm that the Application listed in the Application 
Name field is the same as your selection from the GoToMeeting Integrations list. 
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To configure GoToMeeting preferences 

1. Right-click the GoToMeeting system tray icon and select Preferences. 

2. Select the appropriate category for the set of preferences you want to customize. 

3. Select your preferences. 

4. Click OK. 

Or 

1. When in a meeting, select Preferences from the Tools menu in the Control Panel. 

2. Select the appropriate category for the set of preferences you want to customize.  

3. Select your preferences. 

4. Click OK. 
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Displaying the GoToMeeting toolbar in published Outlook 

Organizers using Outlook published by Citrix Presentation Server may need to activate the 
Outlook toolbar manually in order for it to display the first time.  

 To activate the Outlook toolbar if it doesn’t automatically display 

1. Open Outlook. 

2. Select Customize from the Tools menu. 

 

 

 

 

 

 

 

 

 

3. Place a check mark next to GoToMeeting. 

 

 

 

 

 

 

 

 

 

 

 

 

4.  The Outlook toolbar will appear in your published Outlook on the Citrix Presentation Server. 

 
Note: You may need to restart Outlook for the toolbar to appear.  
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 To remove the Outlook toolbar  

1. Open Outlook. 

2. Select Customize from the Tools menu. 

3. Deselect GoToMeeting from the list of toolbars. 

For more information about using GoToMeeting with Presentation Server, refer to the 
GoToMeeting for Citrix Presentation Server FAQs section at the end of this guide. 
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The GoToMeeting Organizer Web Site 
The GoToMeeting Organizer Web site enables organizers to view their scheduled meetings and 
meeting history and to edit their account information.  

Note: To schedule meetings, organizers need to log in to the organizer application. Please see the GoToMeeting 
Organizer Application section below for more on scheduling meetings. 

 

 

Log In to Your Organizer Web Site 

To access organizer Web site features, organizers must first log in. 

 To log in to your organizer Web site 

1. Open an Internet browser and go to www.gotomeeting.com.  

2. In the left navigation bar, click Log In. 

3. In the Returning Users section, enter your email address and password and click the 
Log In button. 

You will be logged in to your organizer Web site account and taken directly to the My 
Meetings page. 

 

 

View Scheduled Meetings  

The My Meetings feature enables organizers to view any existing scheduled meetings. 

 To view scheduled meetings  

1. Log in to your organizer Web site.  

2. The My Meetings page loads with a list of scheduled meetings showing meeting subject, 
start date and time. 

 

 

To return to the My Meetings page from another page, click My Meetings in the left 
navigation bar. 

© 2007 Citrix Online, LLC. All rights reserved.  23 

http://www.gotomeeting.com/


GoToMeeting™ User Guide 

© 2007 Citrix Online, LLC. All rights reserved.  24 

View Meeting History 

The Meeting History feature enables organizers to view a report of completed meetings for a 
selected month. 

 To view meeting history 

1. Log in to your organizer Web site. 

2. In the left navigation bar, click Meeting History. 

The Meeting History page loads, listing any completed meetings for the present month 
and giving the option to report on meetings from past months. 

3. In the Meeting History section, from the selection boxes select the Month and Year for 
the meeting period you want to review and click the Update History button. 

4. Click the number in the attendee column to display attendee names, email addresses 
and join/leave times. 

The Meeting History section updates and displays the subject, date/time, duration and 
number of attendees for all completed meetings for the selected month.  

 

View and Edit Organizer Account Information 

The My Account feature enables organizers to view and edit their personal account information 
and to change their account passwords. 

 To view account information 

1. Log in to your organizer Web site. 

2. In the left navigation bar, click My Account. 

The My Account Details page loads, displaying organizer account information. 

 To edit account information 

1. Log in to your organizer Web site. 

2. In the left navigation bar, click My Account. 

The My Account Details page loads, displaying organizer account information. 

3. At the top of the My Account Details section, enter your Current Password, make any 
desired account or password changes and click the Save Changes button at the 
bottom of the page. 

 To set conference call preference 

1. Log in to your organizer Web site. 

2. In the left navigation bar, click My Account. 

The My Account Details page loads, displaying organizer account information. 

3. At the top of the My Account Details section, enter your Current Password. 

4. At the bottom of the My Account Details section, check the Use GoToMeeting 
Conference Call Service box to 
set your default meeting 
conference call service to the 
integrated GoToMeeting voice 
conferencing service. To 



GoToMeeting™ User Guide 

© 2007 Citrix Online, LLC. All rights reserved.  25 

provide local toll numbers for multiple countries, click Edit countries. Changes apply to 
all scheduled and future meetings. 

5. Click the Save Changes button at the bottom of the page. 
 

 
hange Account Password 

nizers to change their password. 

 To change account password 

 site. 

Account. 

 organizer account information. 

3. nter your 

C

The My Account feature enables orga

1. Log in to your organizer Web

2. In the left navigation bar, click My 

The My Account Details page loads, displaying

At the top of the My Account Details section, enter your Current Password, e
new password in the New Password and Re-Type New Password fields and click the 
Save Changes button at the bottom of the page. 

Note: Your new password must contain at least 8 characters and include both letters and numbers. 

 

iew and Edit Organizer Account Billing Information V

The billing information feature enables organizers to view and edit their GoToMeeting Personal 
Plan account billing information. 

Note: This feature only appears for GoToMeeting Personal Plan organizers and does not apply to Corporate Plan 
organizers. 

 

 To view account billing information 

ccount. 

ation. 

ying organizer billing information. 

 To edit account billing information 

ccount. 

ation. 

ying organizer billing information. 

4. 

e 

1. Log in to your Organizer Web site. 

2. In the left navigation bar, click My A

3. In the left navigation bar, click Billing Inform

The My Account: Billing Information page loads, displa

1. Log in to your Organizer Web site. 

2. In the left navigation bar, click My A

3. In the left navigation bar, click Billing Inform

The My Account: Billing Information page loads, displa

At the bottom of the My Account: Billing Information section, click the Edit button. 

5. Make any desired billing information change and click the Save Changes button at th
bottom of the page. 
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View Organizer Account Billing History 

The billing information history feature enables organizers to view the history of all activity for 
their account billing information. 

Note: This feature only appears for GoToMeeting Personal Plan organizers and does not apply to Corporate plan 
organizers. 

 

 To view account billing information 

1. Log in to your Organizer Web site. 

2. In the left navigation bar, click My Account. 

3. In the left navigation bar, click Account History. 

The My Account: Account History page loads, displaying organizer billing information. 
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Organizing and Conducting Meetings 
 

Organizer Role Overview 

Organizers have accounts with GoToMeeting that enable them to schedule and conduct 
meetings. An organizer must be present at the start of any meeting as the meeting host.  

Organizers need to first create their accounts and download the GoToMeeting software on their 
computers before they can schedule or conduct meetings.  

Organizers are responsible for creating scheduled meetings or starting impromptu meetings. 
Organizers invite attendees and may do so via phone, email or instant message. 

GoToMeeting meetings can be started from the GoToMeeting system tray icon, the 
GoToMeeting Web site, the GoToMeeting Outlook bar or the GoToMeeting Messenger button. 

Once a meeting starts, the organizer becomes the meeting presenter. During the meeting, the 
organizer may pass the role of presenter to other attendees or promote an attendee to co- 
organizer. 
 

Note: Macintosh-based attendees cannot be made organizers. 

© 2007 Citrix Online, LLC. All rights reserved.  27 



GoToMeeting™ User Guide 

© 2007 Citrix Online, LLC. All rights reserved.  28 

Schedule a Meeting 
Organizers can schedule pre-planned meetings from the GoToMeeting system tray icon. 

 To schedule a meeting 

1. Right-click the GoToMeeting system tray icon and select Schedule a Meeting… 

2. On the Login – GoToMeeting dialog box, enter your Email address and Password and 
click Log In. 

3. On the Schedule Meeting – GoToMeeting dialog box, enter: 

a. Meeting Subject – this is the name of 
the meeting. 

b. Meeting date. 

c. Meeting start and end times. 

d. Conference call information – this is 
the information attendees will use to 
connect to the meeting by phone. You 
can choose to use a provided 
conference call number (toll fees will 
be charged to attendees) or provide 
your own. 

Note: If you are using the GoToMeeting 
conference call service, you can provide toll 
numbers for multiple countries. Please see the 
View and Edit Account Information section of 
this guide. 

e. Meeting password, if desired.  

Note: You must remember the password that 
you create when scheduling a meeting as you 
will be asked for it when you start your meeting 
and/or invite additional attendees. 

4. Once meeting information has been entered, 
click the Schedule button. 

You will be notified your meeting has been 
scheduled. If you are using Microsoft® 
Outlook®, a meeting reminder will be 
generated and give you the option of 
inviting attendees via an Outlook Calendar 
appointment. 

Note: Your meeting will keep showing in "My Meetings" until midnight following the scheduled date. 
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Schedule a Recurring Meeting 

GoToMeeting enables organizers to reuse a meeting ID for future recurring meetings without 
having to create a new meeting ID for each meeting. There are several important 
considerations to keep in mind when creating recurring meetings: 

• The recurring meeting will only appear once in the My Meetings dialog box and the 
Organizer Web site and will be labeled “recurring.” Organizers will need to use their own 
local calendar applications to schedule and track recurring meetings. 

• The Meeting URL/ID stays available indefinitely, as long as it is used at least once every 
40 days. If a recurring meeting is not conducted at least once every 40 days, it 
becomes inactive, the meeting URL/ID will no longer work and organizers will need to 
schedule a new recurring meeting. 

 To schedule a recurring meeting 

1. Right-click the GoToMeeting system tray icon and select Schedule a Meeting… 

2. On the Login – GoToMeeting dialog box, enter your Email address and Password and 
click Log In. 

3. On the Schedule Meeting – GoToMeeting dialog box, enter: 

a. Meeting Subject – this is the name of 
the meeting. 

b. Meeting date. 

c. Meeting start and end times. 

d. Select the “Recurring meeting” check 
box 

e. Conference call information – this is 
the information attendees will use to 
connect to the meeting by phone. 
You can choose to use a provided 
conference call number (toll fees will 
be charged to attendees) or provide 
your own. 

Note: If you are using the GoToMeeting 
conference call service, you can provide toll 
numbers for multiple countries. Please see the 
View and Edit Account Information section of 
this guide. 

f. Meeting password, if desired. 

Note: You must remember the password that 
you create when scheduling a meeting as you 
will be asked for it when you start your 
meeting and/or invite additional attendees.  

4. Once meeting information has been 
entered, click the Schedule button. 

You will be notified your meeting has been 
scheduled. If you are using Microsoft® 
Outlook®, a meeting reminder will be 
generated and give you the option of 
inviting attendees via an Outlook Calendar 
appointment. 

Note: Your meeting will keep showing in "My Meetings" until you delete it.  
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View Scheduled Meetings  

Organizers can view all scheduled meetings via the GoToMeeting application. 

 To view scheduled meetings via the GoToMeeting application 

1. Right-click the GoToMeeting system tray icon and select My Meetings. 

2. On the Login – GoToMeeting dialog box, enter your Email address and Password and 
click Log In. 

The My Meetings - GoToMeeting dialog box appears listing all scheduled meetings. 

 
Note: Scheduled meetings may also be viewed from the www.gotomeeting.com Web site after logging in to your 
account. 

Invite Attendees to a Scheduled Meeting  

An organizer can invite attendees to a scheduled meeting at any time prior to the start of the 
meeting. 

Note: For information on how to invite attendees to a meeting already in progress, please see the Conducting 
Meetings section below. 

 To invite attendees to a scheduled meeting  

1. Right-click the GoToMeeting system tray icon and select My Meetings. 

2. On the Login – GoToMeeting dialog box, enter your Email address and Password and 
click Log In. 

3. On the My Meetings – GoToMeeting dialog box, select the meeting you want to invite 
attendees to by clicking the name in the Subject column, and click the Invite button. 

a. If you have an email application an email will automatically be generated with 
the meeting information included in the body text, simply send the email to 
attendees. 

b. If you do not have an email application, the Meeting Scheduled – GoToMeeting 
dialog box will appear, simply click the Show invitation text link to display the 
invitation information, click the Copy to Clipboard button and paste the 
invitation information to attendees via any desired method. 
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Edit a Scheduled Meeting  

Meeting organizers can edit details for a scheduled meeting at any time prior to the start of the 
meeting. 

Note: Changes to scheduled meetings will not be automatically updated in Microsoft Outlook or other calendar 
applications; neither will meeting attendees receive notice of the change from GoToMeeting. Please be sure to contact 
meeting attendees directly to notify them of any changes. 

 To edit a scheduled meeting  

1. Right-click the GoToMeeting system tray icon and select My Meetings. 

2. On the Login – GoToMeeting dialog box, enter your Email address and Password and 
click Log In. 

3. On the My Meetings – GoToMeeting dialog box, select the meeting you want to edit by 
clicking the name in the Subject column and then click the Edit button. 

4. On the Edit Meeting – GoToMeeting dialog box, make the desired changes to the 
meeting and click Save. 

5. Be sure to contact any previously invited attendees to notify them of the change. 

 

 

Cancel a Scheduled Meeting 

Meeting organizers can delete a scheduled meeting at any time prior to the start of the 
meeting. 

Note: Canceling a scheduled meeting will not be automatically updated in Microsoft Outlook or other calendar 
applications; neither will meeting attendees receive notice of the cancellation from GoToMeeting. Please be sure to 
contact meeting attendees directly to notify them of the cancellation. 

 To cancel a scheduled meeting 

1. Right-click the GoToMeeting system tray icon and select My Meetings. 

2. On the Login – GoToMeeting dialog box, enter your Email address and Password and 
click Log In. 

3. On the My Meetings – GoToMeeting dialog box, select the meeting you want to cancel 
by clicking the name of the meeting in the Subject column and then click the Delete 
button. 

4. On the Meeting Deleted – GoToMeeting dialog box, click OK to confirm deletion of 
meeting. 

5. Be sure to notify any previously invited attendees about the cancellation. 

 

 

Impromptu Meetings 

Impromptu meetings are meetings that are not scheduled in advance. For more information 
about Impromptu meetings, please see the Start an Impromptu Meeting section of this guide. 
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Start a Scheduled Meeting 
Scheduled meetings are any GoToMeeting meetings that have been previously scheduled by 
the organizer in the GoToMeeting application.  

Scheduled GoToMeeting meetings can be started from the GoToMeeting system tray icon, the 
GoToMeeting Web site and the GoToMeeting Outlook bar. 

Note: To start a meeting, the GoToMeeting application must be installed on the PC being used by the meeting 
organizer. For more information on installing the GoToMeeting application please see the Getting Started section of 
this guide. 

 To start a scheduled meeting from the GoToMeeting system tray icon 

1. Right-click the GoToMeeting system tray icon and select My Meetings. 

2. On the Login – GoToMeeting dialog box, enter your Email address and Password and 
click Log In. 

3. On the My Meetings – GoToMeeting dialog 
box, select the meeting you want to start 
by clicking the name in the Subject 
column and then click the Start button. 

Your meeting will start and the 
GoToMeeting Organizer Control Panel will 
appear on the right side of your desktop. 
For more information on the Organizer 
Control Panel see the Organizer Control 
Panel section below. 
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 To start a scheduled meeting from the GoToMeeting Web site 

1. Open an Internet browser and go to www.gotomeeting.com. 

2. In the left navigation bar, click Log In. 

3. In the Returning Users section, enter your email address and password and click the 
Log In button. 

4. On the My Meetings page, locate the scheduled meeting you wish to start and click the 
Start Meeting button. 

 

5. If prompted, click Yes or Grant to accept the GoToMeeting download. 

6. Your meeting will start and the GoToMeeting Organizer Control Panel will appear in the 
right side of your desktop. For more information on the Organizer Control Panel see the 
Organizer Control Panel section below. 

 

 

 To start a scheduled meeting from the GoToMeeting toolbar in Outlook 

1. From the GoToMeeting toolbar in 
Outlook, click the GoToMeeting 
button and select My Meetings. 

2. On the Login – GoToMeeting dialog 
box, enter your Email address and 
Password and click Log In. 

3. On the My Meetings – GoToMeeting 
dialog box, select the meeting you 
want to start by clicking the name in 
the Subject column, and click the Start 
button. 

4. Your meeting will start and the GoToMeeting Organizer Control Panel will appear in the 
right side of your desktop. For more information on the Organizer Control Panel see the 
Organizer Control Panel section below. 
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 To start a scheduled meeting from the GoToMeeting IBM Lotus Notes Actions Menu 

1. From the Actions menu in the Lotus Notes toolbar, select My GoToMeetings…   

2. On the Login – GoToMeeting dialog box, enter your Email address and Password and 
click Log In. 

3. On the My Meetings – GoToMeeting dialog box, select the meeting you want to start by 
clicking the name in the Subject column, and click the Start button. 

4. Your meeting will start and the GoToMeeting Organizer Control Panel will appear on the 
right side of your desktop. For more information on the Organizer Control Panel see the 
Organizer Control Panel section below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 To start a scheduled meeting from the GoToMeeting Toolbar in Microsoft Office 

1. From the GoToMeeting toolbar in 
Microsoft Office, click the 
GoToMeeting button and select My 
Meetings. 

2. On the Login – GoToMeeting dialog box, 
enter your Email address and Password 
and click Log In. 

3. On the My Meetings – GoToMeeting 
dialog box, select the meeting you want 
to start by clicking the name in the 
Subject column, and click the Start 
button. 

4. Your meeting will start and the GoToMeeting Organizer Control Panel will appear in the 
right side of your desktop. For more information on the Organizer Control Panel see the 
Organizer Control Panel section below. 
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Start an Impromptu Meeting 
Impromptu meetings are any meetings that an organizer starts without first scheduling them 
in advance. This is an ideal feature for last-minute and on-the-fly meetings that need to occur 
without prior notice. Impromptu meetings may be initiated either from the GoToMeeting 
system tray icon, from the Microsoft Outlook tool bar, the Lotus Notes Actions menu or from 
an integrated instant-messaging application.  

Note: To start a meeting, the GoToMeeting application must be installed on the PC being used by the meeting 
organizer. For more information on installing the GoToMeeting application, please see the Getting Started section of 
this guide. 

 

 To start an impromptu meeting from the GoToMeeting system tray icon 

1. Right-click the GoToMeeting system tray icon and select Meet Now… 

2. On the Login – GoToMeeting dialog box, enter your Email address and Password and 
click Log In. 

3. Your meeting will start and the GoToMeeting Organizer Control Panel will appear in the 
right side of your desktop. Conference call information will appear in the meeting 
information pane of the Organizer Control Panel.  

Or 

1. Double-click the GoToMeeting system tray icon.  

2. Your meeting will start and the GoToMeeting Organizer Control Panel will appear on 
the right side of your desktop. Conference call information will appear in the meeting 
information pane of the Organizer Control Panel.  

 

 To start an impromptu meeting from the GoToMeeting Web site 

1. Go to www.gotomeeting.com and click the Host a Meeting button. 

2. If prompted, click Yes or Grant to accept the GoToMeeting download. 

3. On the Login – GoToMeeting dialog box, enter your Email address and Password and 
click Log In. 

4. On the Host a Meeting – GoToMeeting dialog box, select Meet Now. 

5. Your meeting will start and the GoToMeeting Organizer Control Panel will appear in the 
right side of your desktop. Conference call information will appear in the meeting 
information pane of the Organizer Control Panel.  
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 To start an impromptu meeting from the GoToMeeting Toolbar in Outlook  

1. From the GoToMeeting Outlook bar, 
click the Meet Now button. 

2. On the Login – GoToMeeting dialog box, enter your Email address and Password and 
click Log In. 

3. Your meeting will start and the GoToMeeting Organizer Control Panel will appear in the 
right side of your desktop. Conference call information will appear in the meeting 
information pane of the Organizer Control Panel.  

 

To start an impromptu meeting from the GoToMeeting Toolbar in Microsoft Office 

1. From the GoToMeeting Toolbar 
in Microsoft Office, click the 
Meet now within button to launch an 
impromptu meeting. 

2. On the Login – GoToMeeting dialog box, enter your Email address and Password and 
click Log In. 

3. Your meeting will start and the GoToMeeting Organizer Control Panel will appear in the 
right side of your desktop. 

4. Click the Show My Screen button and your presentation will start in specific 
application-sharing mode. This means that GoToMeeting will only display the Microsoft 
Office window from which you started the impromptu meeting. 

Note: The GoToMeeting toolbar can be displayed in Microsoft Word, Excel and PowerPoint.  

 

 To share your entire desktop 

1. Click the Screen button on the GoToMeeting control panel. 

2. Select the Screen option.  
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 To start an impromptu meeting from the IBM Lotus Notes Actions menu 

1. From the GoToMeeting Lotus Notes 
menu options, select Meet Now with 
GoToMeeting. 

2. On the Login – GoToMeeting dialog box, enter your 
Email address and Password and click Log In. 

3. Your meeting will start and the GoToMeeting Organizer 
Control Panel will appear in the right side of your 
desktop. Conference call information will appear in the 
meeting information pane of the Organizer Control 
Panel.  

 

 

 

 

 

 

 

 To start an impromptu meeting from an instant-messaging application 

1. Launch the instant-messaging application. 

2. Open a chat communication with the person you would like to invite. 

3. On the side of the chat box, click the GoToMeeting Meet Now tab. 

4. On the Login – GoToMeeting dialog box, enter your Email address and 
Password and click Log In. 

5. Your meeting will start and the GoToMeeting Organizer Control Panel 
will appear in the right side of your desktop. Conference call 
information will appear in the meeting information pane of the 
Organizer Control Panel.  
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GoToMeeting Integrated Voice Conferencing Service 
 

GoToMeeting includes a conference call service at no extra cost to you. All participants dial a 
toll-based number that GoToMeeting provides automatically (to select toll numbers for multiple 
countries, please see the View and Edit Account Information section of this guide). Participants 
are then charged their standard long-distance rate for calling this toll-based number, just as if 
they made a regular long-distance call. You can also provide toll numbers to multiple countries. 
You may decide to use this service or choose another method of bringing audio to your online 
meetings. 

 

 Dialing in to the Conference 

 

Conference Call Features  

At the specified meeting time, dial the conference call number. When prompted, enter the 
access code followed by the # key. (Meeting organizers can enter the access code followed by 
the  key to enable additional conference call features.) 

 

Once in a conference call, participants and organizers can enter commands using their phone 
keypads. Meeting organizers can access additional commands by pressing the  key after 
entering the access code (instead of the # key). 

 
Commands Available to Meeting Organizers 
Command Feature Details 

*2 Count Provides the number of participants currently on the conference call. 
*3 Exit Exits the conference call. 
*4 Menu Provides a menu of available conference commands. 
*5 Listening 

Modes 
Sets listening modes for the audience. Meeting organizers can cycle 
through three listening modes by pressing *5. 
• Open conversation mode (default) 
• Mute the audience – the audience can un-mute themselves 
• Mute the audience – the audience cannot un-mute themselves 

*6 Mute/  
Un-mute 

Mutes the organizer’s line. Pressing *6 again will un-mute the line. 

*7 Secured/ 
Unsecured 

Secures the conference by blocking all other callers from entering. 
Pressing *7 again will open the conference again to callers. 

*8 Tone controls Sets entry and exit tones. Pressing *8 sets the options. 
• Entry and exit tones on (default)  
• Entry and exit tones off 
• Entry tone off exit tone on 
• Entry tone on exit tone off 

 
Commands Available to Participants 
Command Feature Details 

*3 Exit Exits the conference call. 
*4 Menu Provides a menu of available conference commands. 
*6 Mute/  

Un-mute 
Mutes the participant’s line. Pressing *6 again will un-mute the line. 

 

Toll-Free and International Numbers 

You can obtain a toll-free or international access conference call number through most 
conference call vendors. Note that there is often an additional fee for these numbers. When 
scheduling your meeting, enter this number in the Conference Call Information field of the 
Schedule Meetings dialog box. 
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The Organizer/Presenter Control Panel 
When the organizer first joins the meeting the Presenter Control Panel appears on the right 
side of the desktop. The Presenter Control Panel gives organizers and presenters access to 
various organizer and presenter functions. The Presenter Control Panel is comprised of four 
panes – Screen Sharing Pane, Attendee List, Chat, Invite Others and the Meeting Info Pane – 
and the Grab Tab. The Organizer Control Panel has a fifth pane, the Recording Pane, which can 
be displayed by selecting Tools and then Recording from the Organizer Control Panel Menu 
Bar. 

 
 

Note: When the organizer passes the presenter role to another attendee, the Control Panel changes and the Screen 
Tools section is removed and given to the new presenter                                                                                              
 

Screen Tools Pane 
Provides organizers/presenters with a visual 

reminder of On Air status, the ability to show 
their screens, pause showing their screens, pass 

keyboard control and change presenters 

Attendee List Pane 
Provides organizers/presenters with a list of all 
meeting attendees and enables them to make 

other attendees organizers or presenters, 
grant or revoke attendee privileges and 

dismiss attendees 

Chat Pane 
Enables organizers/presenters to chat with 
other attendees, either individually or all at 

once 

Invite Others Pane 
Provides information for organizers to invite 

attendees to meetings via phone, email or 
instant-messaging applications while 

meetings are in progress 

Grab Tab 
Enables organizers/presenters to minimize 

the Control Panel to the side of their 
desktops to display their full desktops to 

attendees and still access Presenter Screen 
Tools 

Meeting Information Pane 
Provided for quick reference, may be edited 

or copied into an email or messenger 
application 
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The Organizer Control Panel Menu Bar 

The Organizer Control Panel menu bar provides access to various application tools not 
specifically related to managing meetings. Menu options include File, Tools and Help. 

 

File Menu 

The File Menu allows organizers to edit how their names and 
email addresses are displayed to other attendees, save the 

chat logs of their meetings as .txt files to their PCs, exit 
meetings without ending them (must first make another 
attendee an organizer) or exit meetings and end them. 

 

 

Tools Menu 

The Tools Menu enables organizers to enable or disable the 
attendee list and/or chat feature for all attendees, access 

Preferences while in session and show the recording pane.  

 

 

Help Menu 

The Help Menu provides access to the online Help file and  
GoToMeeting software version information. 
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The Presenter Control Panel Grab Tab 

The Control Panel Grab Tab enables organizers and Presenters to minimize the Control Panel to 
the side of their screens to display their full desktops to attendees and still access Presenter 
Screen Tools. The Grab Tab changes depending on the status of the Presenter’s display mode.  

There are four main display modes: 

1. Organizer/Presenter has started meeting but no attendees have arrived 

2. Attendees have arrived and the presenter is displaying his or her desktop 

3. Attendees have arrived and the presenter has paused displaying his or her desktop. In 
this mode, screen sharing is paused and attendees see a frozen image of the 
presenter’s desktop. 

4. Attendees have arrived and the presenter has stopped displaying his or her desktop. In 
this mode, screen sharing is stopped and attendees see a “Presentation Stopped” 
message. 

 
No 

Attendees 
have 

arrived 

Attendees 
arrived, 

presenting 
desktop  

Attendees 
arrived, 

presentation 
paused  

Attendees 
arrived, 

presentation 
stopped 

Click and drag to move Grab 
Tab up or down 

Click to hide or display 
 Control Panel 

Shows On Air status 

The Show My Screen button 
displays desktop to attendees. 
Right-click to display multiple 

monitors, a specific application 
or a clean screen 

The Stop Showing Screen 
button stops desktop display 

The Give Keyboard & Mouse 
button grants shared 

mouse/keyboard control to 
another attendee 

The Show Other’s Screen 
button passes the presenter 

role to another attendee 

The Drawing Tools button 
allows the presenter to draw, 
highlight and place arrows on 
the screen, as well as use the 

spotlight and clear all markings 
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A fifth Grab Tab mode is available to organizers only when they are not a presenter: 

 
 Presenter 

controls 
passed to 
another 

Attendee 
Click and drag to move 

Grab Tab up or down 

Click to hide or display 
Control Panel 

Click to change 
presentation between 

Window Mode and Full 
Screen Mode 

Click to pass presenter 
role to another attendee 

Click and drag to move 
Grab Tab up or down 

 

 

 

 

 

Manage Attendees 
Organizers can manage attendees by right-clicking attendee names in the Attendee Pane and 
selecting or deselecting the desired attendee options. 

 

 

 

 

 

 

 

 

 

 

Assigns attendee the role of 
presenter and/or organizer 

Allows the attendee to see the 
list of other attendees 

Allows attendee to control 
the pesenter’s keyboard 
and/or mouse 

Allows attendee to chat 

Sends a chat message directly 
to the attendee Dismisses an attendee 

from the meeting 

Allows the attendee to use the 
drawing tools 

Shows number of attendees 
and maximum number of 
attendees for the meeting 

Indicates attendee role and 
color of assigned drawing tool. 
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 To make an attendee an organizer 

Organizers can make an attendee an organizer to share control of a meeting or to let the 
first organizer leave the meeting and enable the meeting to remain in progress. 

1. In the Attendee List, right-click the attendee’s name and select Make Organizer. 

Note:  Mac-based attendees cannot be made organizers. 

 

 To make an attendee a Presenter 

1. In the Attendee List, right-click the attendee’s name and select Make Presenter. 

Or 

2. On the Screen Tools Pane or the Grab Tab, click the Change Presenter button. 

Note:  Mac-based attendees cannot be made presenters. 

 

 

 To enable an attendee to share the presenter’s mouse and keyboard (when a 
presenter) 

1. In the Attendee List, right-click the attendee’s name and select Give Mouse and 
Keyboard. 

Or 

2. On the Screen Tools Pane or the Grab Tab, click the Give Keyboard & Mouse button. 

 

 To enable the drawing tools for one attendee 

In the Attendee List, right-click the attendee’s name and select Allow Drawing.  

 

 To enable the drawing tools for all attendees 

1. On the Grab Tab, click the Select Drawing Tool button. 

2. Select Attendees can draw. 
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Invite Attendees during a Meeting 

Organizers may invite new attendees to meetings in progress from the Invite Others pane. 
Invitation methods include Phone, Email and Copy/Paste. 

 

Invite Attendees by Phone 

To invite attendees by phone, expand the Invite 
Others pane and select the Phone tab. Call the 

desired attendees and read them the information 
provided on the Phone tab. 

 

Invite Attendees by Email 

To invite attendees by email, expand the Invite 
Others pane, select the Email tab and then click the 

Email button.  

A new Microsoft Outlook or IBM Lotus Notes email 
will be generated with the meeting invitation 

information in the body of the email; simply address 
and send the email to the desired attendees. 

 

Note: The Email option only works with Microsoft 
Outlook and IBM Lotus Notes. If you have another 
email program please chose the Other option to 
invite attendees.   

Invite Attendees by Other Method 

To invite attendees using an email service other 
than Microsoft Outlook, expand the Invite Others 

pane, select the Copy/Paste tab and then click the 
Copy button. 

This will copy the meeting invitation information to 
your Clipboard, where it can then be pasted into 
another email program or an instant-messaging 

application. 
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Chat with Attendees 
Organizers can chat with attendees by using the built-in Chat feature in the Chat Pane. 

 

 
 

 

 To chat with Attendees 

1. Select the desired recipient(s) from the To: drop-down selection field. 

Or  

1. Double-click on an attendee name in the Attendee List. 

2. Enter desired chat message in the Message Entry field. 

3. Click the Send button. 

 To reply to an attendee chat 

1. Select the desired recipient(s) from the To: drop-down selection field. 

Or 

1. Click on the attendee’s name within the Chat Log field. 

2. Enter desired chat message in the Message Entry field. 

3. Click the Send button. 

 To save a chat log 

1. Under the File menu, select "Save Chat Log…."  

2. This opens the "Save Chat Log to a File" dialog that allows you to store the file locally. 
Then browse to the location you would like to save it. 

 

Present at a Meeting 
The organizer who starts the meeting is also the initial meeting presenter. For more 
information about presenting during meetings, please see the Presenting at Meetings section. 

The Chat Log displays the 
text of all public chat and 

chat between two 
attendees 

The To: field enables 
selection of chat 

recipients: choose All or 
a specific attendee 

The Message Entry field 
enables input of chat text 

The Send button 
transmits chat to 
selected recipient(s) 

The Welcome button 
allows the organizer to 
create a Welcome 
message to be delivered 
to attendees when they 
arrive 
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Leave or End a Meeting 
Organizers may choose to either leave a meeting while allowing the meeting to continue or to 
end a meeting completely. 

Note: If an organizer chooses to leave a meeting while allowing it to continue he or she must first designate another 
attendee as the meeting organizer. 

 To leave a meeting and allow the session to continue 

1. Prior to leaving the meeting, be sure to make another attendee the organizer. 

2. From the File Menu, select Exit – Leave Meeting. 

3. On the Leave Meeting? confirmation dialog box, click Yes. 

Note: If you leave a meeting that you organized running, you will not be allowed to host or join another meeting until 
the first meeting is finished.  

 

 To end a meeting 

1. From the File Menu, select Exit – End Meeting. 

2. On the End meeting for everyone? confirmation dialog box, click Yes. 
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 Presenting at Meetings 
 

Presenter Role Overview 
The meeting organizer is always enabled as the first meeting presenter. The presenter role 
may be passed to any PC- based meeting attendee. 

Presenters can show their complete desktops, a clean screen – with no icons or taskbar – or a 
specific application window to all meeting attendees. Presenters may choose to pause showing 
their desktops or applications at any time. Presenters may grant other attendees the ability to 
share control of the presenter’s mouse and keyboard.  

Note that Macintosh-based attendees cannot be made presenters. 

 

 

The Presenter Screen Tools Pane 
When an attendee becomes a presenter, the Control Panel adjusts to incorporate the Presenter 
Screen Tools Pane at the top. The Screen Tools Pane provides the presenter with access to the 
various presenter controls. 

 

Presenter Screen Tools Pane when Screen Sharing is Off 
 

 

 

 

 

 

 

 

 

 

 

 

 

  
Note:  Mac-based attendees cannot be made presenters. 

 

 

The Broadcasting 
Status field notifies 

presenters of the 
status of screen 

sharing 

The Show My Screen 
button displays the 

presenter’s entire 
desktop to attendees 

The Give Keyboard & Mouse 
button grants shared mouse 
and keyboard control to 
another attendee 

The Change Presenter 
button passes the 
presenter role to another 
attendee 

The Screen drop-down 
button allows the 
presenter to share specific 
application windows, or a 
clean screen with meeting 
attendees. 
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The Presenter Control Panel Grab Tab 

The Control Panel Grab Tab enables organizers and presenters to minimize the Control Panel to 
the side of their desktops to display their full desktops to attendees and still access Presenter 
Screen Tools. The Grab Tab changes depending on the status of the presenter role. 

 
 

 

 
No 

Attendees 
have 

arrived 

Attendees 
arrived, 

presenting 
desktop  

Attendees 
arrived, 

presentation 
paused  

Attendees 
arrived, 

presentation 
stopped 

Click and drag to move Grab 
Tab up or down 

Click to hide or display 
 Control Panel 

Shows On Air status 

The Show My Screen button 
displays desktop to attendees. 
Right-click to display multiple 

monitors, a specific application 
or a clean screen 

The Stop Showing Screen 
button stops desktop display 

The Give Keyboard & Mouse 
button grants shared 

mouse/keyboard control to 
another attendee 

The Show Other’s Screen 
button passes the presenter 

role to another attendee 

The Drawing Tools button 
allows the presenter to draw, 
highlight and place arrows on 
the screen, as well as use the 

spotlight and clear all markings 

 

 

 

 

 

 

 

 

 

Use Presenter Controls 
When granted the presenter role the Presenter Controls will appear at the top of your Control 
Panel. 
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Showing the Presenter’s Screen 

 To show the Presenter’s desktop 

1. On the Screen Tools Pane or the Grab Tab, click the Show My Screen button. 

 To show a clean screen 

1.  On the Screen Tools Pane, click the Screen drop-down menu under the Show My 
(Screen) button. 

Or 

1. On the Presenter Grab Tab, right-click the play button. 

2. Select Screen-CLEAN (hide icons, background & taskbar). 

 To show a specific application 

1. On the Screen Tools Pane, click the Screen drop-down menu under the Show My 
(Screen). 

Or 

1. On the Presenter Grab Tab, right click the play button. 

2. Select the application that you want to share, or select Screen-CLEAN. 

 

Note: Hovering over your screen sharing menu selection will display an animated grey frame which indicates what 
attendees will see if selected. If you select an application window that is minimized, the selected window will 
automatically maximize and be presented to attendees. If the presenter opens a window on top of the window being 
shared, screen-sharing will pause until the intruding window is either moved or closed. 

 

 

 

 

 

 

 

 

 

 
Note: The specific application sharing feature will also allow you to share one or all of your multiple monitors if you  
have the hardware already set up.  

 

 To pause showing the presenter’s desktop or application 

1. On the Screen Tools Pane or the Grab Tab, click the Pause Showing Screen button. 

 

Shows your entire 
desktop 

Shows your desktop 
without the icons, 

background or taskbar 
background and taskbar 

Shows only the specific 
application window 
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The Presenter Drawing Tools 

 

 To use a drawing tool 

1. Click the Select Drawing Tools button on the Presenter Grab Tab 

2. Select an appropriate tool from the Drawing Tools drop-down menu 

Note:  Press the Shift key with any drawing tool to make a straight line. 

 To disable a drawing tool 

1. Click the Select Drawing Tools button on the Presenter Grab Tab 

2. Select Normal non-drawing mode 

Or, Press the Esc key to disable a drawing tool without go to the Grab Tab or Control 
Panel. 

 To enable all attendees to use the drawing tools 

1. On the Grab Tab, click the Select Drawing Tool button. (only available in a meeting) 

2. Select Attendees can draw. 

 To enable one attendee to use the drawing tools 

1. Right-click attendee’s name in the control panel attendee list 

2. Select Allow Drawing 
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 To erase drawings 

1. Click the Select Drawing Tool button on the Presenter Grab Tab 

2. Select Erase all drawings 

 

Note:  Only the presenter can erase drawings. Drawing will pause for attendees anytime the presenter pauses the 
presentation.  

 

 

Passing Roles to Attendees 

 To share the presenter’s mouse and keyboard control 

• On the Screen Tools Pane or the Grab Tab, click the Give Keyboard & Mouse button. 

 To change presenters 

• On the Screen Tools Pane or the Grab Tab, click the Change Presenters button. 

 

Note:  Mac-based attendees cannot be made presenters. 
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Recording and Playing a Meeting 
 

Notes on Recording and Playing a Meeting 
Meeting recording allows an organizer to record all screen activity that is presented in the 
GoToMeeting Viewer Window, including desktop and application sharing of other attendees 
presenting in the meeting. 

Meeting recording requires Windows Media Player 9.0 or higher. Windows Media Player 9.0 
currently supports, 2000, XP Home, XP Pro, 2003 Server; therefore, these are the operating 
systems required for recording with GoToMeeting. 

To record audio, an organizer must have a sound card and install and configure an audio input 
device such as a microphone.   

If you are recording a teleconference, you can position the microphone next to the phone or 
set up a phone recording adapter to your phone and line-in input on your computer’s sound 
card.  

Only one recording file is created per meeting. This means that if an organizer clicks Record to 
start the recording and then stops the recording and subsequently restarts the recording 
during the course of one meeting, GoToMeeting will keep recording to one meeting recording 
file. 

The default destination location to save your recording defaults to your My Documents folder.  
You can change the destination location but only before you begin recording. It is 
recommended that the designated location have a minimum of 1.0GB of free space in order to 
accommodate the recording. For optimum recording performance and in-session experience, it 
is recommended that you select a location on your local hard drive. 
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Recording a Meeting 
Note:  The meeting recording feature is only available to meeting organizers or promoted organizers.  

 
 To configure recording settings 
1. From the Organizer Control Panel, click the 

Tools menu, select Recording and then click 
the Settings button.  

 

 

 

 

 

 

 

 

 

 

 

2. Select to record or not 
record audio and choose the 
appropriate input device.   

Note: If you are using a 
microphone that is set as the 
default audio device for your 
computer, select Default Audio 
Input; otherwise, select 
Microphone from the Input drop 
down. If you connected a phone 
recording adapter to your phone 
and line-in input on your 
computer’s sound card, select Line 
In from the input drop-down menu. 
For more detailed information, click 
the Need audio help? link in the 
Audio section of the Recording 
preferences dialog. 

3. Select the appropriate 
recording format.  

4. Designate the location 
where you want to save 
your recording.   

Note: For optimum recording 
performance and in-session 
experience, it is recommended that 
you select a location on your local 
hard drive. 

Note: You cannot change the input device setting or the Save in location setting once you have started to 
record a meeting.  If you do not specify a destination location, the default is My Documents.   

   

http://www.gotomeeting.com/default/help/g2m/g2m_user_help.htm#organizing_and_conducting_meetings/need_audio_help.htm
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 To record a meeting 

1. From the Organizer Control Panel, click the Tools 
menu and select Recording.  

2. Click the Settings button in the Recording pane 
and confirm that your Audio and Video options 
are set appropriately. For detailed Audio and 
Video options, click on the Need audio help? link 
and Learn more links respectively. 

3. In the Save in: section, click the Browse button 
to identify where you would like to save your 
recording. 

4. Click OK to save your settings. 

5. In the Recording pane, click the Record button 
to start recording. 

6. Click Show My Screen to capture the video 
portion of the recording. 

7. Click File and select End meeting for all to view 
the completed recording. 

 

 

Note: The lower you set your monitor resolution, the better the quality of the meeting recording. A resolution of 1024 
x 768 is recommended for optimal recording quality. Since the recording will scale to the highest resolution among the 
presenters in a recorded meeting, it is also recommended that all presenters set their resolution to the same setting. 
Avoid displaying multiple monitors when recording a meeting. 

 

Note: GoToMeeting will begin recording audio input from the time that the organizer clicks the Record button; 
however, the screen recording will not start until the presenter begins showing his/her screen. If screen sharing is not 
turned on during the course of the recorded meeting, the playback will show a black screen and playback the audio 
recording. 

 

Note: You must have at least 500 MB of space on the destination drive to record a meeting. If you have less than 500 
MB of available space, GoToMeeting will display a warning when Recording begins. The Remaining: field in the 
Recording pane refers to the amount of space remaining on the destination drive that is listed in the Recording 
Preferences Save In: field. 

https://www.gotomeeting.com/default/help/g2m/g2m_user_help.htm#organizing_and_conducting_meetings/need_audio_help.htm
http://www.gotomeeting.com/default/help/g2m/g2m_user_help.htm#organizing_and_conducting_meetings/audio_learn_more.htm
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Playing a Recorded Meeting 
GoToMeeting creates one recording file per meeting. If you stop and start a recording during 
the course of a meeting, each recorded segment will be appended to the recording file in 
progress for that meeting. 

 To replay a meeting recorded in the GoToMeeting format 

1. If you haven’t already, end the meeting that you are recording and GoToMeeting will 
automatically save your file with the date and time noted after the name that you gave 
the meeting upon scheduling it. Impromptu meetings will be named with the date and 
time of the meeting followed by Meet Now. 

2. Navigate to the directory that is listed in the Save in: field under the Preferences 
Recording tab. 

3. Click the file name to start the replay.   

4. Press Alt and Enter on your keyboard at the same time to maximize the Viewer 
Window for best replay quality. 

Note: You must have GoToMeeting installed, or download the GoToMeeting codec (G2M2 decoder) to view a meeting 
recorded in the GoToMeeting format. Visit http://www.gotomeeting.com/codec to download the codec. 
 

Note: Playing a recorded meeting back before ending the meeting may cause abnormal playback behavior. Be sure to 
end the meeting before playing it back. 

 To replay a meeting recorded in the Windows Media format 

1. If you haven’t already, end the meeting that you are recording. 

2. GoToMeeting will save your file with the name that you gave the meeting upon scheduling 
it, or Meet Now plus the date and time of the meeting and immediately start to convert 
the recording file into the Windows Media format. 

3. Upon completion of the conversion process, navigate to the directory that is listed as the 
Save in: field under the Preferences Recording tab. 

4. Click the file name to start the replay. 

5. Press Alt and Enter on your keyboard at the same time to maximize the Viewer 
Window for best replay quality. 

Note: The conversion process begins automatically, immediately after you end a recorded meeting in the Windows 
Media format. It may take up to ¾ the time of the actual recorded meeting to complete the conversion. This means 
that a one-hour meeting may take up to 45 minutes to convert to the Windows Media format. Due to the use of CPU 
resources, you may have to wait until the conversion process is complete to resume use of the computer. GoToMeeting 
converts the recorded meeting into a Windows Media Player file after the meeting is over, instead of recording direct to 
Windows Media format, so that impact on CPU resources doesn’t bog down the computer during the meeting. 
 

Note: Playing a recorded meeting back before ending the meeting may cause abnormal playback behavior. Be sure to 
end the meeting before playing it back. 
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Distributing a Recorded Meeting 
Depending on the size, meeting recordings can be zipped and sent by email, sent by FTP or 
posted on a Web site. 

 To distribute a recorded meeting in the GoToMeeting format 

1. Deliver the recorded meeting by email or FTP or post to a Web site. 

2. Recipients must have Windows Media 9.0 or higher to view the recorded meeting. 

3. Request recipients to install the GoToMeeting Codec at 
http://www.gotomeeting.com/codec if he/she has not already installed it, or is not running 
the GoToMeeting software on his/her computer. 

 To distribute a recorded meeting in the Windows Media format 

1. Upon completion of the conversion process, deliver the recorded meeting by email or FTP 
or post to a Web site. 

2. Recipients must have Windows Media 9.0 or higher to view the recorded meeting. 

 

Troubleshooting Recording and Replaying a Meeting 

To troubleshoot recording and playback 

Please see http://www.gotomeeting.com/s/audiohelp and http://www.gotomeeting.com/s/audiolearn. These 
pages are also linked from the recording tab of the organizer preferences. 
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Attending Meetings  
 

Attendee Role Overview 
A meeting attendee can be any person with an Internet connection. All that is needed to join a 
meeting is the meeting ID and, if required, the meeting password. Attendees do not need to 
subscribe to GoToMeeting; they meet at no cost to them, as guests of the organizer. 

Attendees may be given the role of organizer and/or presenter from the original meeting 
organizer at any time once a meeting has started. 

Note: Mac-based attendees cannot be made organizers or presenters. For more information about Mac-based 
attendees, please see the Attending Meetings on a Macintosh section of this guide. 

 

Join a Meeting 
There are several ways to join a meeting depending on how you receive the meeting invitation. 
Joining a meeting requires no pre-registration or software installation or configuration. 

Note: When joining a meeting, remember to also conference into the meeting using the conference call information 
provided by your meeting organizer. 

 To join a meeting from an email invitation, Outlook meeting appointment or 
instant message invitation 

1. Open the email, appointment or instant message that contains the meeting invitation. 

2. Click the link provided in the email to join the meeting. 

3. If prompted, click Yes or Grant to accept the download. 

4. If requested, enter the meeting password provided by your meeting organizer. 

5. When prompted, type in your name and optionally, your email address. 

 To join a meeting from the GoToMeeting Web site 

1. Open an Internet browser and go to www.gotomeeting.com. 

2. In the left navigation bar click the Join a Meeting button. 

3. If prompted, click Yes or Grant to accept the download. 

4. On the Join a Meeting – GoToMeeting dialog box, enter the Meeting ID you received 
from your meeting organizer. 

5. If requested, enter the meeting password provided by your meeting organizer. 

6. When prompted, type in your name and optionally, your email address. 

 To join a meeting from the GoToMeeting system tray icon 

1. Right-click the GoToMeeting system tray icon and select Join a Meeting. 

2. On the Join a Meeting – GoToMeeting dialog box, enter the Meeting ID you received 
from your meeting organizer. 

3. If requested, enter the meeting password provided by your meeting organizer. 

4. When prompted, type in your name and optionally, your email address. 

Upon clicking OK on the Name and Email dialog, you will be entered into the meeting 
and the Attendee Control Panel and the GoToMeeting Viewer Window will appear. 
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GoToMeeting Attendee Application Components 
Once attendees join a meeting they see two GoToMeeting Attendee components, the 
GoToMeeting Attendee Control Panel and the GoToMeeting Viewer Window. 

 

 

 

 

 

 

 

GoToMeeting Viewer 
Window 

GoToMeeting Attendee 
Control Panel 



GoToMeeting™ User Guide 

© 2007 Citrix Online, LLC. All rights reserved.  59 

The Attendee Control Panel 
When attendees first join a meeting, the Attendee Control Panel appears on the right side of 
their desktops and then minimizes to the side. The Attendee Control Panel gives attendees 
access to various meeting functions. The Attendee Control Panel is comprised of two panes –
Attendee List, Chat and Invite Others – and the Grab Tab. 

 

 

Attendee List Pane 
Provides a list of all meeting attendees  

Chat Pane 
Enables attendees to chat with other 

attendees, either individually or all at once  

Grab Tab 
Enables attendees to minimize the Control 
Panel to the side of their desktops and still 

access Viewer tools 

Meeting Information 
Provided for quick reference 
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The Attendee Control Panel Menu Bar 

The Attendee Control Panel menu bar provides access to various application tools not 
specifically related to attending a meeting. Menu options include File, View, Tools and Help. 

 

 

File Menu 

The File Menu allows attendees to edit how their names and 
email addresses are displayed to other attendees, save the 

chat logs of meetings as .txt files to their PCs and exit 
meetings.  

 

 

View Menu 

The View Menu enables attendees to select how to display 
the Viewer Window on their desktops.  

 
Tools Menu 

The Tools Menu enables attendees to access the Preferences 
Menu, where they can allow or forbid bubble messages to 

appear when another attendee chats or when GoToMeeting 
notifies them of system-related actions such as attendees 

joining or leaving a meeting.  

 

 

Help Menu 

The Help Menu provides access to the online Help file and to 
GoToMeeting software version information. 

 

 

 

 

The Attendee Control Panel Grab Tab 
The Attendee Control Panel Grab Tab enables attendees to minimize the Control Panel to the 
side of their desktops and change the way the presenter’s desktop is displayed in the Viewer 
window. The Grab Tab changes depending on the status of the Viewer Window. 

 
 Attendee 

Grab Tab 
with 

Viewer in 
Window 

Mode 

Attendee 
Grab Tab 

with 
Viewer in 

Full 
Screen 
Mode 

Attendee Grab 
Tab with 

Drawing tools 
Enabled by 
Presenter 

Click and drag to move 
Grab Tab up or down 

Click to hide or display 
Control Panel 

Click the view button to 
change display modes 

Click and drag to move 
Grab Tab up or down  
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The Attendee Drawing Tools 

 

Note:  Drawing Tools must be enabled by the presenter before they will appear to attendees. The presenter is the only 
one who can erase drawings. Drawing will pause when the presenter pauses the presentation. 

 To use a drawing tool 

1. Click the Select Drawing Tool button on the Attendee 
Grab Tab 

2. Select an appropriate tool from the Drawing Tools 
drop-down menu 

Or 

1. Right-click anywhere on the Viewer Window  

2. Select an appropriate tool from the Drawing Tools 
drop-down menu 

 

 

 To disable a drawing tool 

1. Click the Select Drawing Tool button on the Attendee Grab Tab 

2. Select Normal non-drawing mode 

Or 

1. Right-click anywhere on the Viewer Window  

2. Select Normal non-drawing mode from the Drawing Tools drop-down menu 

Or 

Press the Esc key to disable a drawing tool without going to the Grab Tab or Control Panel. 
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Chat with Other Attendees 
Attendees can chat with other Attendees by using the built-in Chat feature in the Chat Pane. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 To chat with attendees 

1. Select the desired recipient(s) from the To: drop-down selection field. 

2. Enter desired chat message in the Message Entry field. 

3. Click the Send button. 

 To reply to a chat 

1. Select the desired recipient(s) from the To: drop-down selection field. 

Or 

1. Click the Attendee’s name within the Message Entry field. 

2. Enter desired chat message in the Message Entry field. 

3. Click the Send button. 

Note: If enabled by the meeting organizer, attendees can chat with other attendees during a meeting. 

 To save a chat log 

1. Under the File menu, select "Save Chat Log…."  

2. This opens the "Save Chat Log to a File" dialog that allows you to store the file locally. 
Then browse to the location you would like to save it. 

To auto-save chat logs 

1. Click the General category on the GoToMeeting Preferences dialog and check Chat 
Logs. 

2. In the Save in: box, select the directory you would like to save the chat log under. 

3. Click OK. 

The Chat Log displays the text of 
all public chat and chat between 

two attendees 

The To: field enables 
selection of chat 
recipients: choose All or  
a specific attendee 

The Message Entry field 
enables input of chat text 

The Send button 
transmits chat to 
selected recipient(s) 
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The GoToMeeting Viewer Window 
The Viewer Window is where the image of the presenter’s desktop is displayed to attendees. 
The Viewer Window can be displayed in either a Window Mode or a Full Screen Mode. 

 

 

GoToMeeting Viewer 
Window in Window Mode, 
with Presenter’s Control 

Panel minimized. 

 

 

GoToMeeting Viewer 
Window in Full Screen 
Mode, with Presenter’s 

Control Panel minimized 
and the Attendee Control 
Panel Grab Tab available. 

 

                                        

 

 

Viewer Window in 
Window Mode 

Viewer Window in Full-
Screen Mode 

Attendee Grab Tab 
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Configure the Viewer Window 

The Viewer Window may be configured to display in either Window mode or Full Screen mode. 

 To display the Viewer Window in Window mode 

1. From the Attendee Grab Tab, click the Window Mode button. 

Or 

2. From the Attendee Control Panel View Menu, select Window. 

 

 To display the Viewer Window in Full Screen mode 

1. From the Attendee Grab Tab, click the Full Screen Mode button. 

Or 

2. From the Attendee Control Panel View Menu, select Full Screen. 

 

 

 

Share Presenter Keyboard and Mouse 
At any time during a meeting presenters may share control of their keyboard and mouse with 
any other attendee to enable that attendee to share control of applications on the desktop 
being displayed. 

When an attendee is given shared control, the 
GoToMeeting application notifies all attendees of 
the change in control by providing a System 
Bubble Message. 

 

Note: Even though an attendee may gain shared keyboard and mouse control of the presenter’s desktop, the 
presenter always retains overriding control by simply moving their mouse. 
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Become a Presenter 
At any time during a meeting the presenter may pass the presenter role to any other attendee 
to enable that attendee to share his or her desktop with the other attendees. 

Note: Mac-based attendees cannot be made presenters. 

When an attendee is made a presenter the GoToMeeting application shows a dialog box 
notifying the attendee that he or she has been made presenter and updates his or her Control 
Panel and Grab Tab with Presenter Tools. 

The new presenter can click Show My Screen to present his/her entire desktop or click the 
down arrow to select a specific application window. 

For more information about being a presenter, please see the Present at a Meeting section. 

 

 

 

 

 

 
 
B
At any time during a meeting th
ecome an Organizer 

e organizer may promote any other attendee to the role of co-
organizer to enable that attendee to take over or share in meeting management functions. 

Note:  Mac-based attendees cannot be made organizers. 
 

hen an attendee is promoted to the role of co-W
organizer, the GoToMeeting application notifies th
attendee of the change by providing a System Bubb
Message and updates his or her Control Panel and Grab
Tab with Organizer Tools. 
 
or more information abou

e 
le 

 

t being an organizer, please see the Presenter Control Panel and 

eave a Meeting 
 meeting at any time. 

 To leave a meeting 

 Control Panel File Menu, select Exit – Leave Meeting. 

F
Manage Attendees sections. 

 

L
An attendee may leave a

1. From the Attendee

2. On the Leave Meeting? confirmation dialog box, click Yes. 

 Enables presenter to 
share a specific 
application window, or 
a clean desktop  

 Enables presenter to 
share his/her entire 
desktop 
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Attending Meetings on a Macintosh 

 
Notes on Attending Meetings on a Macintosh 
A meeting attendee can be any person with an Internet connection. All that is needed to join a 
meeting is the meeting ID and, if required, the meeting password. Attendees do not need to 
subscribe to GoToMeeting; they meet at no cost to them, as guests of the organizer. 

GoToMeeting supports Macintosh-based attendees; however, attendees who join a meeting 
from a Macintosh computer cannot be promoted to the role of organizer or presenter. 

  

Join a Meeting(Macintosh) 
There are several ways to join a meeting depending on how you receive the meeting invitation. 
Joining a meeting requires no pre-registration or software installation or configuration. 

Note: When joining a meeting, remember to also conference in to the meeting using the conference call information 
provided by your meeting organizer. 

For more information on joining and leaving a meeting, please refer to the corresponding 
sections of this guide. 
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GoToMeeting Attendee Application Components (Macintosh) 
Once attendees join a meeting they see two GoToMeeting Attendee components, the 
GoToMeeting Attendee Control Panel and the GoToMeeting Viewer Window. 

 

 

 

 

 

 

 

GoToMeeting Viewer 
Window 

GoToMeeting Attendee 
Control Panel 

GoToMeeting Menu Bar 
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The Attendee Control Panel (Macintosh) 
When attendees first join a meeting, the Attendee Control Panel appears on the right side of 
their desktops and then minimizes to the side. The Attendee Control Panel gives attendees 
access to various meeting functions. The Attendee Control Panel is comprised of three panes –
Attendee List, Chat and Meeting Info – and the Grab Tab. 

 

 

Attendee List Pane 
Provides a list of all meeting attendees  

Chat Pane 
Enables attendees to chat with other 

attendees, either individually or all at once  

Grab Tab 
Enables attendees to minimize the Control 
Panel to the side of their desktops and still 

access Viewer tools 

Meeting Information 
Provided for quick reference 

Expansion Triangle 
Allows attendees to collapse and expand 

each pane of the Control Panel 
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The Attendee Control Panel Menu Bar (Macintosh) 

The Attendee Control Panel menu bar provides access to various application tools not 
specifically related to attending a meeting. Menu options include File, View, Tools and Help. 

 

 

File Menu 

The File Menu allows attendees to edit how their 
names and email addresses are displayed to other 

attendees and save the chat logs of their meetings as 
rich text files to their hard drive..   

 

View Menu 

The View Menu enables attendees to select how to 
display the Viewer Window on their desktops.  

 

 

Drawing Menu 

The Drawing Menu enables attendees to select from a 
menu of drawing tools. The drawing tools are only 

available if enabled by the presenter.  

 

 

Window Menu 

The Window Menu allows attendees to designate an 
active window. 

 

 

Help Menu 

The Help Menu provides access to the online Help file. 
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The Attendee Control Panel Grab Tab (Macintosh) 
The Attendee Control Panel Grab Tab enables attendees to minimize the Control Panel to the 
side of their desktops and change the way the presenter’s desktop is displayed in the Viewer 
Window. The Grab Tab changes depending on the status of the Viewer Window. 

 
 Attendee 

Grab Tab 
with 

Drawing 
Tools 

Enabled 
by 

Presenter 

Attendee 
Grab Tab 

with 
Viewer in 

Full 
Screen 
Mode 

Attendee Grab 
Tab with Viewer 

in Window 
Mode 

Click and drag to move 
Grab Tab up or down 

Click to hide or display 
Control Panel 

Click the view button to 
change display modes 

Right-click the view button 
to show the View Menu 

Click to select a drawing 
tool 

 

 

 

 

 

 

 

Note: If the attendee Control Panel is closed, a chat button will appear on the Grab Tab to alert the attendee to 
incoming chat messages. Click the button to open the chat pane. 

 

The Attendee Drawing Tools (Macintosh) 

 

Note: Drawing Tools must be enabled by the presenter before they will appear to attendees. The presenter is the only 
one who can erase drawings. Drawing will pause when the presenter pauses the presentation. 

 To use a drawing tool 

1. Click the Select Drawing Tool button on the Attendee Grab Tab 

2. Select an appropriate tool from the Drawing Tools drop-down menu 

Or 

1. Right-click anywhere on the Viewer Window  

2. Select an appropriate tool from the Drawing Tools drop-down menu 

 

 To disable a drawing tool 

1. Click the Select Drawing Tool button on the Attendee Grab Tab 

2. Select Normal non-drawing mode 

Or 

1. Right-click anywhere on the Viewer Window  

2. Select Normal non-drawing mode from the Drawing Tools drop-down menu 

Or 

Press the Esc key to disable a drawing tool without going to the Grab Tab or Control Panel. 
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Chat with Other Attendees (Macintosh) 
Attendees can chat with other attendees by using the built-in Chat feature in the Chat Pane. 

 

 

 
 

 

Note: A recipient must be selected in the To: field in order to activate the Message Entry field and the Send button. 
 

 

 To chat with attendees 

1. Select the desired recipient(s) using the up/down arrow to the right of the “To:” field. 

2. Enter desired chat message in the Message Entry field. 

3. Click the Send button. 

 To reply to a chat 

1. Select the desired recipient(s) from the up/down arrow to the right of the “To:” field. 

2. Enter desired response in the Message Entry field. 

3. Click the Send button. 

 To save a chat log 

1. Under the File menu, select "Save Chat Log…."  

2. This opens the "Save Chat Log to a File" dialog that allows you to store the file locally. 
Then browse to the location you would like to save it. 

 

Note: If enabled by the meeting organizer, attendees can chat with other attendees during a meeting. 

The Chat Log displays the text of 
all public chat and chat between 

two attendees 

The arrows enable 
selection of chat 
recipients: choose 
Organizer(s) Only, 
Presenter Only, All-Entire 
Audience or a specific 
attendee 

The Message Entry field 
enables input of chat text 

The Send button 
transmits chat to 
selected recipient(s) 
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Share Presenter Keyboard and Mouse (Macintosh) 
At any time during a meeting presenters may share control of their keyboard and mouse with 
any other attendee to enable that attendee to share control of applications on the desktop 
being displayed. 

When an attendee is given shared control, the GoToMeeting application notifies all attendees of 
the change in control by placing a keyboard icon next to the attendee’s name in the Attendee 
List. 

 

Note: Even though an attendee may gain shared keyboard and mouse control of the presenter’s desktop, the 
presenter always retains overriding control by simply moving their mouse. 

 

Leave a Meeting (Macintosh) 
An attendee may leave a meeting at any time. 

 To leave a meeting 

1. From the Attendee Control Panel File Menu, select Quit GoToMeeting/GoToWebinar. 

2. On the Leave Meeting? confirmation dialog box, click OK. 
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Tips for Success 
 

Prior to Meeting Start 
• If you plan to share your entire desktop, turn off any instant-messaging applications, 

notification software or other programs that may interrupt or distract from the meeting.  

• Turn off any streaming media applications that may take up bandwidth and resource-
intensive applications that may be taxing processor ability.  

• Set the desktop display to a neutral background and adjust display settings to a mid-range 
resolution (e.g., 1024x768) to improve the display for attendees with lesser settings. This is 
also the optimal setting for recording a meeting. 

• Clean up your desktop before a meeting. Eliminate wallpaper and icons that may distract 
your attendees. 

• Have the documents you wish to share ready to be accessed in one or two clicks. 

• Run a trial meeting with a friend to anticipate questions and to familiarize yourself with the 
format of your online presentation. 

Managing the Meeting 
• Arrive a few minutes early to greet the attendees as they arrive and start the meeting on 

time. It also helps to have a welcome presentation running during this time. Your presence 
in these opening minutes can help establish the tone and direction of the meeting. 

• Create a welcome message under the Meetings tab of the organizers preferences to greet 
your attendees as they arrive at the meeting. 

• Provide an agenda at the start of the meeting, including estimated duration, and stick to it. 

• Inform attendees what the purpose/goal of the meeting is, what to expect and when and 
how to ask questions and participate in the meeting.  

• Provide information on how to use equipment or services and how to get assistance if 
needed. 

• Nominate a co-organizer to monitor and respond to the chat log when someone is 
presenting. 

• Encourage participation by using open questions such as “What would you suggest?” and 
“How do you feel about…?” 

• End the meeting clearly. Make sure all the attendees know that the meeting is formally over 
and stay on the line to address any last questions. 

Managing the Conference Call 

• Call in to the meeting from a location where there is little background noise. 

• Consider globally muting participants at the start of the meeting to avoid noise issues. Turn 
off system prompts and sounds for when attendees join or leave a meeting. 

• Avoid using cellular and cordless phones because of static and use the phone handset or a 
headset instead of speakerphones because of background noise, tunnel effect and sentence 
clipping. 

• Turn off your call waiting. The beep of a new call on another line is heard by everyone on 
the teleconference. 

• Avoid putting your phone on hold during a teleconference. Your hold music will play into the 
conference call, and make it impossible for the other attendees to continue the meeting. 

• Introduce yourself when you begin speaking and ask other attendees to also identify 
themselves before speaking. Not everyone in the meeting may know everyone else’s voice. 

• If you find you are having a sound quality issue, hang up and dial back in. Sometimes these 
problems clear themselves up when the bad connection is terminated. 
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FAQs 
 

General FAQs 
I never received my meeting organizer invitation email. What should I do? 

Sometimes the meeting organizer invitation email will get blocked by your email server as 
spam. If you do not have the ability to check email in a spam folder, check with your 
Administrator to see if the invitation can be resent. Otherwise, ask your Administrator to 
contact the account manager for help. 

 

How can I see what future meetings I have scheduled? 

To see what meetings you have scheduled, right-click on the GoToMeeting system tray icon 
and select My Meetings. After your login email address is verified, you will see the list of 
scheduled meetings. 

Likewise, you can log into www.gotomeeting.com to view your scheduled meetings. 

 

I forgot my password. What should I do? 

First make sure you are entering your correct login email address and password – note that 
your password is case sensitive and must contain at least 8 characters and include numbers 
and letters.   

If you still need to reset your password, just visit 
https://www.gotomeeting.com/en_US/forgotpassword/forgotPassword.tmpl and enter your 
email address. You can also reach this page via the www.gotomeeting.com login page. An 
email will automatically be sent to your login email address to reset your password. 

 

How long will my past meetings appear in my Meeting History? 

Past meetings will appear in your Meeting History for 90 days, after which they will be deleted 
from the system. If you would like to keep records of your meetings for audit purposes, have 
your Administrator run a Meeting History report at least once every 90 days. 

 

Why does the meeting pause when I open a window that I am not sharing? 

The application sharing feature is set up to ensure that you are only sharing the specific 
window that you have selected. If you inadvertently open a different window, GoToMeeting will 
automatically pause the meeting to protect your privacy. Screen sharing will resume once you 
have moved or closed the obstructing window. 

 

What happens when I stop showing my screen? What do my attendees see? 

When you click the Stop button, screen sharing will be turned off and you will no longer 
transmit your desktop contents to your attendees.  Instead, your attendees will see the 
Waiting Room screen until you click the Play button to resume screen sharing. Corporate Users 
can contact their Account Manager to upload a company logo to display on the Waiting Room 
screen. 
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How do I share one application and nothing else? 

A presenter can share a single application by right-clicking the screen-sharing icon on the 
control panel grab tab and then selecting the application to share from the list of applications 
presented. 

 

After I've given keyboard and mouse control away, how do I get it back? 

As a security feature, you can regain control of your desktop/laptop by simply moving your 
mouse. The change of control happens almost instantaneously. At any time you can revoke an 
attendee’s shared control of your mouse and keyboard if you want to prevent him/her from 
regaining control. 

 

Are there any files or folders left on the attendee computer after the session ends? 

Some downloaded files do remain after a meeting so that the attendee may join future 
meetings more quickly (without having to download all the files again). However, the files are 
inactive, will not consume system resources, do not compromise security and perform no 
functions until the attendee joins another meeting and the files are engaged by a new meeting 
ID. If desired, an attendee may uninstall all GoToMeeting files using the Add/Remove 
Programs feature in the Windows control panel. 

 

Why would I make someone else an organizer in my meeting? 

If you created a meeting and needed to leave you would want to make someone else the 
organizer. The meeting would proceed without you without interruption. Or, if you wanted to 
have a co-organizer to monitor and respond to attendee chat questions while you focused on 
the task of presenting. Note that Mac-based attendees cannot be made organizers. 

 

Is there a charge for using the integrated conference call service?  

GoToMeeting is packaged with a conference call service at no extra cost to you. You may 
decide to use this service or choose another method of bringing audio to your online meetings. 
Our service provides a toll-based number that is dialed by all meeting participants. Participants 
are then charged their standard long-distance rate for calling this toll-based number, just 
as if they made a regular long-distance call. There is no additional charge for the conferencing 
feature. 

 

How do I save chat sessions from my meetings?  

Under the File menu, select "Save Chat Log…." This opens the "Save Chat Log to a File" dialog 
that allows you to store the file locally. Alternately, under the General category of your 
GoToMeeting preferences, you can check the box marked “Chat Logs” to automatically save 
your chat logs to your local computer after each meeting. 
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Do you offer training for GoToMeeting? 

Yes, you can find a series of self-paced tutorials on the GoToMeeting Web site under the 
Support link in the left navigation menu. 

We also offer real-time training twice weekly, every Tuesday at 2PM (PDT) and Thursday at 
8AM (PDT)  
 
1. Ten minutes before your preferred training time, click the link below: 
    www.gotomeeting.com/join/446680854 

2. Dial in to the conference call using the number and passcode below:  
    North American Number: (888) 371-8921 
    International Number: (617) 614-4893 
    Passcode: 25653086 

No registration or reservations are needed. 

 

Is there a log of who has attended my meetings?  How can I view information about 
past attendees? 

Sign in to www.gotomeeting.com with your email address and password. Select My Meetings 
from the menu options on the left. Select sub menu, Meeting History.   

The information is grouped by month. You can see your meetings in chronological order. Each 
meeting contains the number of attendees, shown in blue. Click this number, and a window 
opens listing the attendees’ first and last names, their email addresses and their join/leave 
times. This information can be copied into another document.    

 

Are Macintosh or Linux operating systems supported by GoToMeeting? 

Currently Linux operating systems are not supported by GoToMeeting, either to host or join a 
meeting. However, GoToMeeting does support Macintosh-based attendees but does not 
support hosting or presenting from a Macintosh. For more information, see the “Attending 
Meetings on a Macintosh” section of this guide. 

 

Is audio streaming supported in GoToMeeting? 

Audio streaming is not an available option with GoToMeeting at this time, but we are 
continually looking to improve the features while still keeping the same ease-of-use. Look for 
more features to become available in future versions. 

 

Is video streaming supported in GoToMeeting? 

While we still do not support streaming video, our GoToMeeting technology is fast enough to 
keep up with screen changes on the desktop, so it appears as if it is streaming video. It does 
not at this time support audio along with the video. 
Because more data is being sent to all meeting attendees, bandwidth usage will go up for all 
meeting participants. The amount will depend on the resolution and length of the video. 
Also, certain versions of Windows Media Player with DirectX (Microsoft DirectX is an advanced 
suite of multimedia application programming interfaces (APIs) built into Microsoft Windows 
operating systems), will not display the video. 
To enable video display for your meetings, you need to disable Hardware Overlay for your player. 
Please see your media player’s help section for directions on how to disable Hardware Overlay. 
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Recording FAQs 
Why can't I record? 

In order to record a meeting, you must have Windows Media Player 9 or above. You can 
download this for free at http://www.microsoft.com/windows/windowsmedia/default.aspx.   
   
Can meeting attendees record a meeting using the GoToMeeting recording feature? 

No, only the meeting organizer or a promoted organizer has access to the GoToMeeting 
recording feature. 

  

How do I record a meeting with audio? 

To record the audio portion of a meeting, you must have a sound card and also install and 
configure an audio-input device such as a microphone. If you are recording a teleconference, 
you can position the microphone next to the phone or set up a phone-recording adapter to 
your phone and line-in input on your computer’s sound card. In addition, be sure that the 
Record Audio option is selected from the Recording tab in your GoToMeeting preferences.  

 

How can I improve the quality of my meeting recordings? 

The lower you set your monitor resolution, the better the quality of the meeting recording.  We 
recommend a maximum resolution of 1024x768 for optimal recording quality. 

  

What happens if I click the Stop button in the recording pane in the middle of a 
meeting recording and then resume recording? 

The meeting recording stops when you click the stop button in the recording pane and resumes 
recording when you click the record button. However, a new file is not created for each 
recorded segment of the meeting; it is simply appended to the existing recording file. You will 
only have one recording file per meeting. 

  

What happens if one of the presenters on my recorded meeting has a larger screen 
than I do? 

The recording will have the dimensions of the largest screen presented during the meeting. 
The portions of a recorded meeting that show a smaller screen will display the image centered 
in the playback window with a black border around it.  

  

How do I save my meeting recording? 

Recordings are automatically saved to the path indicated under the recording tab in your 
GoToMeeting preferences when you end or leave a meeting. Meet Now meetings will be named 
with the date and time plus the words “Meet Now,” while Scheduled Meetings will include the 
meeting subject in the file name. Note that you cannot change the location where you would 
like to save a recording once you have clicked the record button. If you cannot find your 
recording, check the path listed in the “Save in” pane of the recording preferences. 

 

Where are my recorded meetings stored? 

The default destination for recorded meetings is the My Documents folder. You can change the 
destination location only before recording begins. It is recommend that the designated location 
have a minimum of 1.0GB of free space to accommodate the recording. 
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How do I play back a recorded meeting? 
First you must end the meeting that you are recording. GoToMeeting will then automatically 
save your file with the meeting name you designated at the time of scheduling as well as the 
date and time. Impromptu meetings will be named with the date and time of the meeting 
followed by “Meet Now.” 

1. Navigate to the directory that is listed in the Save in: field under the Preferences 
Recording tab. 

2. Click the file name to start the replay.  

3. Press Alt and Enter on your keyboard at the same time to maximize the Viewer 
window for best replay quality. 

*To view a meeting recorded in the GoToMeeting format, you must either have GoToMeeting 
installed, or download the GoToMeeting codec (GoToMeeting 2.0 decoder) at 
http://www.gotomeeting.com/codec.  

**To view a meeting recorded in the Windows Media format, you will have to wait until the 
conversion process is complete. GoToMeeting converts the recorded meeting into a Windows 
Media Player file after the meeting is over so that the impact on CPU resources doesn’t bog 
down the computer during the meeting. The conversion may take up to 75% of the actual 
recorded meeting length to complete. 

*** Playing a recorded meeting back before ending the meeting may cause abnormal playback 
behavior.  Be sure to end the meeting before playing it back. 

 

When I play a recorded meeting, it plays back scrambled. Is there something I can 
do to fix this? 

If you experience scrambled playback of a meeting recording, which can happen if the 
presenter used a multiple monitor setup, you can try the following: 

In Windows Media Player, go to the Tools menu and select Options.  Click Advanced under the 
Performance tab.  In the dialog that pops up, uncheck “use video mixing renderer”.  Click OK 
until you have dismissed all dialogs.  Play the video again, and it should play unscrambled. 

 

Can I edit a recorded meeting?  

GoToMeeting Desktop Recording and Playback allows you to record and preserve meetings as 
they actually occurred. You can use the editing software of your choice to edit those files.  

 

What is the best way to distribute a recorded meeting? 

If a meeting recording is small enough, you can distribute it as an email attachment. However, 
most recorded meetings will be too large for emailing. If this is the case, you may want to 
upload the file to a Web server for easy access. Remember that viewers must have 
GoToMeeting or the GoToMeeting 2.0 Video Codec installed to watch a recorded meeting 
created in the GoToMeeting format. The GoToMeeting 2.0 Video Codec is available to download 
for free at: http://www.gotomeeting.com/codec and can be distributed freely. Regardless of 
the format, all viewers must have Windows Media Player 9 or higher to view the recording. 
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GoToMeeting for Citrix Presentation Server FAQs 
Organizer FAQs 

Once I start a meeting, it runs on my local desktop. When I try to invite other 
attendees using the “By email” option on the Organizer Control Panel, GoToMeeting 
doesn’t integrate with my published version of Outlook. How can I resolve this? 

You need to verify that the option that is selected in your GoToMeeting "Preferences" under the 
'Integrations" category matches the option that is selected in the "Advanced" section of the 
"Integrations"  

 

Attendee FAQS 

When I am designated the presenter at a meeting, I can only show the applications 
that are published to me from Presentation Server and nothing that is on my local 
desktop. How can I present my local desktop? 

Contact your Citrix Presentation Server Administrator about installing GoToMeeting on 
Presentation Server. By installing GoToMeeting and configuring the recommended settings on 
Presentation Server, all GoToMeeting sessions will be redirected to the desktop. Running a 
meeting on the local desktop allows you to present everything on your desktop, if you choose. 
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Contact Support 
 
Please direct any support questions to: gotomeetingcare@citrixonline.com  

Or call: 

• (800) 263-6317        (U.S. and Canada, toll free) 

• 001-800-574-4234    (Mexico, toll free) 

• 00-800-5744-2340    (International, toll free) 

• (805) 690-5753        (direct dial) 
 

Please direct any billing or account questions to: accounts@citrixonline.com  

Or call: 

• (888) 646-0016        (U.S. and Canada, toll free) 
 

To provide feedback on the GoToMeeting product, click the feedback link located in the footer 
of the GoToMeeting Corporate Web site or on the GoToMeeting Personal Web site here: 
https://www.gotomeeting.com/en_US/pre/feedback.tmpl 
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